THE KEY PRODUCTION GUIDE TO SUPPLYING ARTWORK

introduction
Thank you for using Key Production to
manufacture your vinyl, CD or DVD.
We will endeavour to make your product
the best possible, because we know that
your release is important to you, and so it’s
important to us too.
We have made this guide to help you prepare
your artwork, please read through it, even if
you are an experienced graphic designer.
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essential information
Supply your artwork as PDF, Quark, Photoshop, InDesign, or Illustrator files.
Other formats may be acceptable, but will incur extra charges.
All images must be at least 300ppi.
Images with fine lines or small text should be 600ppi, and bitmaps should be 1200ppi.
Colours should be CMYK or greyscale.
(If spot colours are used then these should be indicated).
Send all of the fonts that you have used.
Please zip or stuff the fonts to avoid corruption.
Text should be at least 5pt. (7pt if the font is fine or white on a dark background).
Do not mark centre holes on the label artwork.
For vinyl or for CD.
Do not leave template lines on top of the artwork.
(Unless it is in an editable format).
Mark all relevant information on the pasteboard or in an area outside of the bleed.
(Page numbers, spot colours or special instructions).

TIP

Please clearly name your files by catalogue number.
This is important if you are sending the files via ftp or email, so they are easy for us to locate.

Print out your artwork. Cut it out and
assemble to make a mock-up of how
it will look when printed. This will give
you the chance to double check your
artwork before you send it to us, and
it is useful to us if you send us the
mock-up with your artwork disc.
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what should be included on your artwork?
What you include on your artwork is up to you - some releases have a lot of written text, logos and information and some have hardly any.
It might be useful for you to look at records or CDs in your own collection and see what is usually included.
This is a list of things that you may want to include:
The name of the artist or band, and the title of the release
The catalogue number on the label and cover (this is usually on spine of the cover)
‘Made in E.U’ (if your release will be sold within the U.S.A. this should be on all parts)
Publishing and Copyright information
The band/label’s web address & social media details (twitter/facebook/bandcamp etc)
Your logo
Barcode (see page 5 for details)
Where is was recorded, who recorded it, the year it was recorded
The names of the musicians/singers/participants
TIP

When you have finished your artwork,
print it out and give copies to the three
most fastidious people you know - they
might spot some mistakes that you
haven’t noticed! It is better to find the
mistakes before you print hundreds or
thousands of copies!

Thank you list - a chance to thank those who have helped you

All artwork should be proof read before it is given to us.
We cannot be held responsible for proof reading or spelling errors.
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barcodes
Some shops or distributors insist on the release having a barcode.
Barcodes should not be less than the minimum size and adhere to acceptable colour
combinations to be readable by barcode scanners. Preferably vector or 1200ppi and single
colour 100% black.
There must be a clearing space of 3mm either side of the edge of the barcode.

minimum height = 10mm

minimum width = 32mm

3mm

3mm

If you would like us to place a barcode on your artwork then indicate where on your artwork you
would like the barcode.
We recommend that you have a black on white barcode, as if you use colours in your barcode
then there is a danger that the barcode will not work on some barcode readers.

ACCEPTABLE COLOUR COMBINATIONS

NON-ACCEPTABLE COLOUR COMBINATIONS

BLACK BARS ON WHITE

BLUE BARS ON WHITE

RED BARS ON WHITE

YELLOW BARS ON WHITE

GREEN BARS ON WHITE

BROWN BARS ON WHITE

BEIGE BARS ON WHITE

BLACK BARS ON BLUE

TIP
BLACK BARS ON YELLOW

BLACK BARS ON RED

GREEN BARS ON RED

BLUE BARS ON YELLOW

BLUE BARS ON RED

BROWN BARS ON RED

BLACK BARS ON GREEN

BLACK BARS ON BROWN

RED BARS ON YELLOW

RED BARS ON BLUE

RED BARS ON BEIGE

RED BARS ON GREEN

If you are eligible for a Key Production
barcode then leave a space that is
32mm wide x 22mm high.
This is what your barcode
will look like (actual size).
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putting the pages in order
24 PAGE BOOK

Booklet artwork should be supplied paginated in printers pairs as illustrated:
4 PAGE BOOK

8 PAGE BOOK

12 PAGE BOOK

16 PAGE BOOK

24

1

20 PAGE BOOK

4

1

8

1

12

1

16

1

20

1

2

23

2

3

2

7

2

11

2

15

2

19

22

3

6

3

10

3

14

3

18

3

4

21

4

5

4

9

4

13

4

17

20

5

8

5

12

5

16

5

6

19

6

7

6

11

6

15

18

7

10

7

14

7

8

17

8

9

8

13

16

9

12

9

10

15

10

11

14

11

12

13

IMPORTANT

It is not always obvious to us what the
page order is! Please help us by marking
the page numbers on the pasteboard or
outside the crop marks, or supply us
with a print out of your booklet, with
page order clearly indicated.
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bleed
WHAT IS BLEED?
Bleed is the area outside the trim line that
will be trimmed off when finished. It is usually
3mm, but may be more, it will be indicated
on the template supplied to you.
Bleed is important because when the printed
parts are trimmed to the correct size there
is a chance that the cutter will shift slightly.
Most printers have a cutter tolerance of
3mm. This means that the cutter could cut
3mm either side of the crop line. (In reality,
it is rare that the cutter is this far out, but
it sometimes is 1mm out). By extending
images and background to cover 3mm all
around the edges of your artwork means that
it will not be noticable on your finished print
if the cutter trims the artwork slightly outside
the trim line.

THIS DOTTED INDICATES THE BLEED - 3mm ADDED ALL AROUND THE OUTSIDE OF THE PRINT.
THIS LINE INDICATES THE CROP SIZE, WHERE THE PRINT WILL BE TRIMMED TO.
THIS SHADED AREA INDICATES 3mm FROM THE CROP LINE, TEXT SHOULD NOT BE PLACED IN THIS AREA.

The text should be placed at least 3mm
away from the edges of the artwork,
otherwise there is a danger that it will
get cropped.
Images that come to the edge of the
page should have an extra 3mm of
bleed added.

This version is wrong. The text is
right up against the edge of the page
and it is likely that some text will get
cut at the edges.
These images do not have bleed, so
there is a danger that there will be a
white space at the edge of the page
on the finished cropped print.

It is essential to include bleed on all of your
artwork except CD or DVD labels.
Safe area is 3mm inside the edges of the
artwork. You need to keep all text and
important graphics within this area.

Extend images to the edge of the bleed area, and keep text within the safe area.
For example, if the document size is 120mm x 120mm then the image should extend 3mm all
around, so that the size of the image is 126mm x 126mm.
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image resolution
IMAGES SIZE AND RESOLUTION

USING IMAGES IN INDESIGN

USING IMAGES IN ILLUSTRATOR

All images must be at least 300ppi. Images
with fine lines or text are recommended to be
600ppi. Bitmaps should be 1200ppi.

If you are using InDesign, use the Preflight
function to check if the images you are using
are high enough resolution and are CMYK or
greyscale.

In Illustrator the ppi and colour mode can
be seen on the top bar when the image is
highlighted.

If the images are lower resolution than
recommended then there is a danger that the
finished printed article may not be as good
quality as expected.
Remember that if images are placed into
a layout program such as InDesign, Quark
XPress or Illustrator at more than 100% then
the relative resolution will be lowered. For
example, if an image is 300ppi and then used
at 200%, the relative resolution is 150ppi.

File > Preflight > Links and Images
This example shows that the image is
unsuitable for print because it is an RGB
JPEG, with a resolution of 144ppi.

When you change an image from RGB to
CMYK you may notice that the colours
become less vibrant.
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spot colours and varnishes
SPOT COLOURS AND VARNISHES

PANTONE COLOURS

VARNISHES OR FOIL BLOCK

Careful use of spot colours, spot varnishes
or foil blocking can make your finished
design really stand out.

Pantone colours (also called ‘spot colours’)
are specific coloured inks, some of which
are flourescent or metallic. If you would like a
very bright colour then you might wish to use
a flourescent pantone.

Beware of using varnishes or foil block on
areas that are too small.

If you are supplying your artwork in
Photoshop then please use a separate,
clearly indicated layer for the parts of the
artwork which will be printed as pantone or
have a special varnish or foil block.
If you are using InDesign or Illustrator
then please colour up the parts using the
program colour swatches or use a seperate
layer and make a note regarding this on the
pasteboard.

Images or text that are to be printed as foil
block need to be supplied as a vector.

If your design includes some special spot
colours (this could be a bright fluorescent
green, a specific shade of red, or a metallic
gold), or you would like some parts of your
artwork to appear more glossy then please
indicate the pantone reference number of the
ink.
Beware of using metallic pantone inks on
record labels, as the manufacturing process
can distort the finished effect.
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artwork for CD labels
Designing for a CD or DVD onbody label
is different to designing for paper. The way
that the design is printed on to the disc
means that some designs work better than
others. Look at some of the CDs in your own
collection and think about what makes them
good or not!

COLOURS

TEXT

CD onbody artwork can be set up as either
full colour (CMYK) or using spot (Pantone)
colours. When using Pantone colours please
select colours from PANTONE SOLID
COATED library

Text must be bigger than 5pt. Small text
prints better as 1 colour (ie single channel
100% black or a solid pantone colour). If
using fine text or White out of coloured text
then it should be bigger than 7pt.

Please use the template supplied to you, do
not change the size or layout of the template.

If you have a full colour design then it is
recommended that a white base is also used.

For the best results make text vector.

Remember that there is a central hole, but do
not mark this on your artwork.

List the colours that you use at the edge of
the template. Indicate if you want a white
base or not.

CD label artwork does not need bleed.
Include a catalogue number on your artwork

IMAGES
Use images that are 600ppi. If you are using
a design with a lot of fine lines then it is best
to use vector lines (Illustrator eps) rather than
bitmap images (Photoshop)

If the disc does not have a base colour then
the silver of the disc will show though where
there is white (or tones) on your artwork . The
silver part of the disc does not go right to the
centre of the disc, there is a ring around the
centre which is clear plastic. Be aware of this
if you are planning to have the silver of the
disc as part of your design.

Text that is part of an image (ie done in
Photoshop) may not print as clear, and
should always be at least 600ppi.

CHECKLIST

Colours are clearly marked.
Design is CMYK or spot colours.
Images are 600ppi (or more).

Avoid subtle tonal shades and tints that are
less than 15% or over 85% as gradients do
not print well on to discs.

Catalogue number is included.

Due to print techniques and media surface it
is impossible to colour match to paper parts.

Fonts are included (if applicable).

Indicate is a white base is required.

FULL COLOUR
CMYK with white base

2 COLOUR
with no white base
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essential information for vinyl records
SLEEVE ORIENTATION

CUT OUT HOLES ON THE SLEEVE

Sleeves can be top opening or side opening. Most LP sleeves are side opening, and the inner
sleeves are top opening, but you can choose to be different if you prefer! Please clearly indicate
which you would like for your sleeve.

If you want holes cut out of the sleeves
please let us know. If you mark the holes on
your artwork then make sure that we can
remove these markings if we need to.

THE LABELS

SIDE OPENING SLEEVE

TOP OPENING SLEEVE

THE CORRECT ORIENTATION TO SET UP 		
ARTWORK FOR A SIDE OPENING SLEEVE.

The record label needs to be ‘baked’ when it
is fixed on to the record, this means that heat
is applied to the labels which can cause an
alteration of colour. Be wary of using metallic
pantone colours on labels.
Please make sure that the labels sides are
clearly marked.

THE CORRECT ORIENTATION TO SET UP 		
ARTWORK FOR A TOP OPENING SLEEVE.
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essential information for Photoshop users
GETTING STARTED

BEFORE YOU START

BLACK

Open the PDF that has been supplied to you
in Photoshop.

Before you begin to asemble your design,
please check that the size of the template is
correct. Although most of our PDF templates
are full size, occassionally a template will
be not 100% in scale. If you suspect that
the template size is not correct then please
inform your planner, who will send you a
corrected template.

Black can made up of just black ink or can
contain some cyan magenta and yellow.

A dialogue box similar to this will appear:

Make a new layer on top of the template
layer and use this to put your artwork on.

COLOURS
Set Resolution to 300ppi (or 600ppi if your
design has text less than 12pt or has fine
lines or if you are designing a CD label).
Set Mode to CMYK Color.
Click OK and the PDF will be open and ready
for you to use.

It is important to design your artwork in
CMYK rather than RGB. To print your design
the images need to be CMYK.
When images are converted from RGB to
CMYK the colours often appear more dull.

Black which is just black ink will appear more
dull than a ‘rich black’ which contains cyan,
magenta and yellow.
The default CMYK Photoshop black (when
using CMYK setting of ‘Default Photoshop
5’) has values of 63/52/51/100, this is a rich
black.
If you are using a lot of black in your design
then make sure that the blacks match. If you
have blacks that don’t match then you could
end up with unwanted boxes and lines on
your artwork when it is printed. Mismatched
blacks are very difficult to spot on screen,
so it is important to check for mismatched
blacks. You can easily do this by opening the
CHANNELS palette and view each channel
individually.

If the image uses spot colours (Pantones),
a varnish or has a cut out, mark this on a
separate, clearly marked layer.
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colour settings and ink coverage in Photoshop
COLOURS SETTINGS

INK COVERAGE

CHECKING LEVELS

We recommend using Default Photoshop
5 CMYK settings. To set this, go to Edit >
Color Settings.

The TOTAL MAXIMUM INK COVERAGE
should be less than 300%.

To check the ink levels in Photoshop:
Open the info palette (Windows > Info).

This means the CMYK value of any colour
used should not add up to more than 300.

Click on the small arrow on the top right of
the palette and select Info Palette Options.

For example, if an image is made up of
cyan = 85%
magenta = 85%
yellow = 90%
black = 100%

Change the First Colour Readout to Total
Ink, and the Second Colour Readout to
CMYK Color.

the total ink coverage is 360
(85 + 85 + 90 + 100 = 360)
A dialogue box will appear.
The MINIMUM INK VALUES should be
OVER 5% for cyan, magenta and black, and
over 10% for yellow.
If any of the values are less than these then
there is a possibility that the ink will not print.

Hold your cursor over
the darkest parts of
the image and check
the Total Ink Readout.

Select Photoshop 5 Default CMYK as the
CMYK setting and click OK.
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how to supply artwork in Photoshop
HOW TO SUPPLY YOUR ARTWORK
When you have finished your design, you can send us your artwork in a number of formats;
JPG save as the highest quality.
TIF save without compression, either flattened or unflattened.
PSD supply either flattened or unflattened. If unflattened please supply fonts.
PDF save at the highest quality, with no compression.

If you supply an unflattened file then please delete any empty or hidden layers.
Include any fonts that you have used, (zip or stuff the fonts to avoid them corrupting).
If you have used spot colours or varnishes in your artwork these should be marked clearly on a
separate layer (see spot colours and special varnishes).

CHECKLIST

Fonts included (if applicable).
Files are 300ppi (or 600ppi).
3mm bleed included.
Total ink limit less than 300%.
Colour mode is CMYK or greyscale.
Spot colours are indicated clearly.

14

essential information for Illustrator users
GETTING STARTED

IMAGES

Open the PDF template supplied to you in
Illustrator and create a new layer to place
your design on.

If you are placing images into your design
then make sure that the images are at least
300ppi. (see page 8 for more information).

BEFORE YOU START

FONTS

Before you begin to asemble your design,
please check that the size of the template is
correct. Although most of our PDF templates
are full size, occassionally a template will
be not 100% in scale. If you suspect that
the template size is not correct then please
inform your planner, who will send you a
corrected template.

Send us the fonts used in your design, or
turn the fonts to outline. To do this select all
the type, go to Type in the top menu, and
select Create Outlines.

Check that the colour mode is CMYK, It is
important to design your artwork in CMYK
rather than RGB. To print your design the
images need to be CMYK.
When images are converted from RGB to
CMYK the colours often appear more dull.

COLOURS
Make sure that all colours are CMYK or
greyscale or spot colours if required.
If the image uses spot colours (Pantones),
a varnish or has a cut out, mark this on a
separate, clearly marked layer.

CHECKLIST

Fonts included or turned to outline.
Images are 300ppi (or 600ppi).
3mm bleed included.

FILE FORMAT

Total ink limit less than 300%.

You can supply your files as ai, eps or PDF.

Colour mode is CMYK or greyscale.
Spot colours are indicated clearly.
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essential information for InDesign users
GETTING STARTED

THINGS TO CHECK

Open the template supplied to you and work
on the artwork layer (or make a new layer for
your artwork if needed).

Please make sure that you check the following:
Fonts are included.
and all text is at least 5pt (7pt for white out text)
All images used in the design are supplied.
Image resolution is over 300ppi (600ppi for fine details or 1200ppi for bitmap images).
Colours are CMYK.
Colour swatches and Images should be CMYK or greyscale or Pantone spot colours.
Ink coverage is less than 300%.
All colour swatches and images should be within the maximum and minimum ink limits,
see page 13 for information on maximum and minimum ink coverage
Pagination is correct.
(see page 6 for further information)
Bleed is included.
(see page 7 for further information)

TIP

Extra information is listed on the pasteboard.
(page numbers, label sides, colours etc).

Use the Preflight feature (File > Preflight)
to check the fonts and images.
Use the ‘Package’ feature to collect all
of the fonts and images used in your
artwork. (If you are using Quark XPress
the use the ‘Collect for Output’.)
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how to send us your artwork
There are a few ways that you can send your artwork to us:
BY FTP

BY WEB-BASED FTP

An FTP program is needed to upload files to the Key Production ftp site.

You can also use a web-based ftp program,
such as hightail or wetransfer.

If you are using a PC then you can use Filezilla or Core FTP, (both are free to download).
www.coreftp.com
filezilla-project.org
If you are using a Mac then you can download Cyberduck (donation) or Fetch (free trial) from
these links,

www.hightail.com
www.wetransfer.com
Please send the notification to the planner
who sent you the artwork templates.

download.cnet.com/Cyberduck/3000-2160_4-10246246.html
fetchsoftworks.com
All of these programs come with instructions.
Please inform the planner who sent you the templates when your artwork is uploaded.

The Key Production FTP information is:
URL: ftp.keyproduction.co.uk
Use the ANONYMOUS option (no password needed).
Upload your artwork into the INCOMING folder.

BY POST
Burn your artwork onto a disc, remember to
write the catalogue number and/or the artist
and title of the release clearly on the disc.
It is helpful if you include a print-out of your
artwork, write any instructions that you think
are relevant, and a contact phone number
and/or email address.
Address the disc to the planner who sent you
the artwork templates at:
Key Production
Unit 41, Tileyard Studios,
Tileyard Road,
London N7 9AH
UK
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your proofs
Within 5 working days of receiving correctly
set up artwork we will send you a set of PDF
proofs.
It is very important that you check your
proofs very thoroughly as it is your last
chance to make sure that everything is
correct before your release is printed.
The PDF is NOT to be used for colour
approval due to variances in screen settings
and resolution.
If you notice anything that is not correct then
please let your planner know immediately.
If you are happy with your proofs then email
your planner to let them know that you are
happy for us to proceed with printing.

Positioning.
Is everything in the right place?
Barcode.
Is the barcode the correct number?
Spelling.
This is your last chance to spot any howlers!
Labeling.
Are the page numbers marked up correctly?
Are the vinyl labels sides correct?
Fonts.
Do all the fonts look like they should?
Overprint & knockout.
Does everything look how it should when you switch on ‘overprint preview’.

Production will not start before your
approval.
TIP

To view overprint you must use Adobe
Reader 7 or better, download free at
www.adobe.com set your preferences on
PDF viewer on Page Display, then click
onto overprint preview.
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frequently asked questions
What ICC profiles should i use?
Please do not include any profiles.

What Color Setting should I use for Adobe Illustrator, Photoshop
or InDesign?
Use Photoshop 5 Default CMYK for the CMYK setting for all Adobe
programs. This gives a good rich black that is well within ink
tolerance levels.

What is PPI?
PPI stands for pixels per inch. If your artwork is 300ppi then this
means there is 300 pixels per inch on your artwork.

How do I make a P sign?
You need to use a special font.
You can download a font which has a P and also C for free here:
www.ufonts.com/fonts/bundesbahn-pi-3.html

I have followed your instructions and have connected to your
FTP but my file will not upload?
The most common reason for files not uploading is that the file name
includes ‘special characters’ (ie @£#/& etc).
File names should only use letters and numbers, underscores and
hyphens. Any other characters can stop your file from uploading.

Type a capital ‘P’ for P and capital ‘C’ for C.
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